CDOT Batch Printing
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Batch Printing is used to print multiple files at one time. This tool can assist you in organizing
Plot Sets for milestone submittals. A .job file can be saved and called back for future printing. It
can also be used for plotting to PDF.

1. Select Batch Print in MicroStation from the file pull down menu.

?-._’1_ C:\Projects\12345\Design\Drawings\12:

| File Edit Element Settings Tools  Utilities W

T [ mew... Chrl+M
_ & Open... ChrO
Close ChrH-w
= E Save Chr+S
E Save fs..,
Campress 3
Save Settings Chrl+F

Reference
E Raster Manager
Models
E Import 3
1 Export 3
b Print Preview
£ S Print kP
Batch Print

[

T Associate. ..

= Properties Ale+Enter
r‘i“' Prokection 3
B4 Send...

Note: You can be in any MicroStation file when you run the Batch Print process.

The following default dialog box will display.

F [untitled] - Batch Print -
File Edit Specifications
=d =&

Specifications Caontrolling Printing:

Frinter: 1117 Frinter

Frint Area: SHEET_Plot-Boundary

Layout: b arimize

Drigplay: Azl Dizplay

# « | File tdodel

* o
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2. To add files to the batch process, select Edit > Add Files and/or Edit > Add Active

File.

-

F= [untitled] - Batch Print

File | Edit Specifications
e _

Add Files...
Add Active File

Printe
Frirt

Lapn
Dizpl

#

| Model

Note: Add Active File adds the design file that is open in MicroStation.

Otherwise, select Add Files and navigate to your project directory. Select the files
you are adding to the batch process. Select Add.

Select Design Files to Add

Files:

[ 123454 pproximatefuantities01.dgn

Directaories;

chprojectsh 1 2345 designtdrawingss

123454 pproximateuantities0]. dan
12345E arthwork Quantities01. dgn
12345GeneraltotesShestll. dan
12345G enerall otesSheetl2 dgn
12345PlanProfile##. dgn
12345PlanSheettti. dan
12345ProfileShesti$. dgn

123455 andardPlanList dgn
123455URY T abShest dan
12348TitleShest. dan

12345T ypicalSection . dgn

ME&S Standard Plans List Index.dan

List Files of Type:
* dan

|

Selected Files

[ ch
[ projects
12345
[ design
P2 drawings
£ Cross Sections
=3 Reference_Files
1 Tabs

Dirives:

ElR

=

Daone
Cancel

Help

1 ek

Note: You can hold down the Ctrl or Shift key to select multiple files.
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After you add the files, select Done.

Select Design Files to Add

Directories:

chprojectzsh 2345hdesignhdramwingsh

= e
[P projects
[ 12345
(7= design
= drawings
1 Cross_Sechions
3 Reference_Files

1 2345F'I;anF'l0fileﬁﬂ. dgn
12345PlanSheettt. dan
12345ProfileShesti$.dgn

23455 £ Tabs
123485URYT abSheet. dan
12345T ypicalSectionf#. dgn
M&S Standard Plang List Indes.dgn
Lizt Files of Type: Drrives:
* dgn il | =2

Selected Files

Done

Cancel

Help

chprojectsh 1 2345 designh\ drawings'1 23455 pproximatel uantities01.dgn
chprojectsh 2345 designhdrawingsh 1 2345E arthwork Quantities11.dgn
c:hprojectsi 2345 designhdrawingsh 1 23456 eneralM otesSheet01 .dan
chprojectzh] 2345 designhdrawingsh1 23455 eneralt otes Sheet 02 dgn

=
-
=

| e

3. The batch process default settings include sending the selected files to a printer,
defining the Print Area to SHEET _Plot-Boundary, setting the print scale to
Maximize, and setting the pen table for printing in black and white.

-

F= [untitled] - Batch Print

=JOE

File Edit Specifications
Nedsg = = =l
Specifications Controlling Printing:
Printer: 11317 Printer
Frint Area: . SHEET_Plot-Boundary
Laout: b aximize
Dizplay: Ag-ls Display
# | File todel -
1 ohp M 23454pprodimatelluantities01.dgn COOT Default
2 chpros A 2345E atbark Quantiies] . dgn COOT Default
3 chproje. M2345GeneralMotesSheet0].dgn COOT Default ]
4 chproje. M2345GeneralMotesSheetd2. dgn COOT Default
5 ohprojectz.. A123455tandardPlanLizt.dagn COOT Default
1 ﬂ_‘
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4.

Version 03.02

If the default specifications settings need to be changed, select Specifications >
Manage. Another option is to <RIGHT CLICK> in the Specifications Controlling
Printing window to access the Specifications menu. Otherwise, proceed to step 6

on page 10.

-

F= [untitled] - Batch Print

File Edit | Specifications

Select, .,

=M=

Properties

Manage

Frinter:
Frint Area:
Lanpout;
Diizplay:

SHEET_Plot-Boundary
M aximize : T

Ag-ls Dizplay Right Click

# | File | kodel -
chp. M 2345Apprasimateuantities01.dgn COOT Default
chpro. M1 2345E arthork Quantities0] .dgn COOT Default
chproje.. M2345GeneralM otesSheet0l .dgn COOT Default
chproje.. M2345GeneralM otesSheetD2 dgn COOT Default
COOT Default

chprojects.. M1 23455tandardPlanLizt. dgn
4 3

N o= La o —

You can select specifications for the Printer, Print Area, Layout, and Display as

shown in the Batch Print Specification Manager below.

F2 Batch Print Specification Manager

Types Specifications

Frirter 11«17 Printer Froperties
Frint Area 8.5x11 Printer

Layout PDF Printer Bename...
Display T

Copy...

Dielete

i
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Select Printer under Types. Choose between the 11x17 Printer, the 8.5x11 Printer,
or the PDF Printer. To review the settings of the specification, highlight the item
and select the properties button.

-

=y Batch Print Specification Manager [g =

Types Specifications

Frinter 1141 7 Frinter Properties
Frint Area 8.5411 Printer

Lapaut FDF Printer Bename...
Drigplay New

Copy...

Delete

Uil

Note: This dialog defines whether or not you want the batch process to be sent to a
printer or to a PDF file. For this example we are sending files to an 11x17 printer,
see step 7 for printing to a PDF file. The following examples can be used whether
you are sending the files to a printer or to a PDF file.

Print Area specifies the criteria used to define the printable area boundary. The
specifications default to the outer boundary of the standard CDOT sheet border.

-

F= Batch Print Specification Manager

[Topes | [[speciications
Frinter SHEET_Plat-Boundary Properties

Frint Area
Layout Rename...
Dizplay T

Copy...

Delete

Uil

To review these settings further, select Properties.

-

E-’]_ Batch Print Specification Manager

Types Specilications

Printer SHEET_Plot-Boundary

Frint Area

Layout Rename...
Display

Hew .

L
e

Copy...

Delete
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After you have selected Properties, you notice both the Master File and References
checked ON under Search Files. If the level SHEET_Plot-Boundary is not found
in the Master File as a cell, it will search for the level in the Reference files
associated with the sheet file. This level defines the outer boundary of the CDOT

standard sheet border.

SHEET_Plot-Boundary Properties

Frint Boundary

Method:  Shape >

W Levet [SHEET FlotBoundary __j
T Colar [0

[ Style: l—

[ Weight r—

[+ Process Multiple Boundary Elerments

Search Files
W Master File
[V Beferences

Cancel

As an option, you can narrow the search by adding the name of the Reference file
containing the border under Search Files. However, this step is not necessary.

SHEET_Plot-Boundary Properties

Fieference View

Wiew: 1 hut
Frint Boundary
Method:  Shape >
W Level [SHEET_Plot-Baundary ﬂ
™ Color [0
S T
[ wieight: r—

W Process Multiple Boundary Elements

ok
Cancel

Search Files
W Master File

W References

11:17 PEF Generator Border. dgn
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If you have problems with batch printing a sheet file containing multiple sheet
borders, such as cross sections, check the properties of the print area specification
and verify the toggle Process Multiple Boundary Elements is checked on. Select
the OK button when finished.

SHEET_Plnt—Bnundary Properties

Reference Yiew

Cancel

Wiew: 1 b
Print Boundary Search Files
Method:  Shape hd [V Master File
W Level |SHEET_Plot-Boundany j [V References
™ Color 11417 PEP Generator Barder. dgn
[ Style:
[ ‘weight

I]F Process Multiple Boundary Elementsl

Layout specifies the scale of the plot. If a file contains more than one sheet with
multiple scales, select Maximum.

Typez
Printer
Frint Area
L ayout
Dizplay

E:j Batch Print Specification Manager

BEX

Specifications -
1=100
1=20
1=200
1=30
1=40
1=50
1=E0
b animize -

Properties
Bename. ..

Mew

il

Copy...

Delete

Display is the last setting in the Batch Print Specification Manager. The As-Is
Display Specification sets up the way various elements print. Select Properties to
review the Print Attributes display settings.

E-—fj Batch Print Specification Manager

=0k

Types
Frinter
Frint Area
Layout
Dizplay

S pecifications
Aiz-lz Display

Properties

Bename...

il

Mew...

Copy....

i

Delete
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The batch process defaults to As-Is. This setting will read the MicroStation View
Attributes setting for each design file. The Pen Table defaults to CDOT-
PenTable.tbl. This table is for black and white printing. If you would like to use a
different pen table, click the Browse button and select the desired table from the list.
The file path defaults to C:\Program Files\Workspace-CDOT\Standards-
Global\MicroStation\Tables\Pen. Select OK when finished.

As-lIs Display Properties

Pritit sttributes
al bz ¥ Level Symbalogy: iz ¥ | 2
Constuctions;  Asis ¥ Line Styles:  As-is 71 Cancel J
Data Fields: Asiz ¥ Line Weights: As-iz ¥
Dimenzions:  Asis ¥ Patterns: Asis ¥
Dizplayzet, Agiz ¥ Frint Border,  Agiz ¥
Fast Cellz: Aziz ™ Fef Boundaries: As-is ¥
Fazt Curves: Agiz ¥ Tags dsiz ¥
FastFont: Asizs ¥ Tert Agiz ¥
Fence Boundary:  Asiz ¥ Tewt Modes: Asiz ¥
Fill. Azie ™ Broken dzzociation Symb;  Asis ¥
Pen T able

Filerame: | bal\MicroStation' T ables\Pen\CDOT-PenT able.thl Browvze. .

Additional Options

L

Color mode: As-is

Once you have the Batch Print Specification Manager setup, select X to close out of
this dialog box.

2 Batch Print Specification Manager [g [y
| Types Specifications
Frinter Aiz-lz Display Properties
Frint &rea
Lapout Bename...
Dizplay

MNew...

Copy...

Delete

i
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Any changes made in the Batch Print Specification Manager will be shown in the
main Batch Print dialog box.

F= [untitled] - Batch Print -
File Edit Specifications
Nedé& &
Specilications Cantrolling Printing
Printer: 11417 Printer
Frint &rea: SHEET_Plot-Boundary
Lanout; b aximize:
Dizplay: Ag-ls Digplay
# - | File kodel
1 hp M234BApproximatelluantities0l.dan CDOT Default
2 chpro. A 2345E athwork Quantiies01.dgn COOT Default
3 chproje. M 2345GeneralMotesSheet01.dgn CDOT Default
4 chproje. N12345GeneralMotesSheet02.dogn COOT Default
5 ohprojects.. M 234585tandardPlanlist.dgn CDOT Default
B chprojects' 12345, \12345TileSheet. dgn CDOT Default

5. These settings can be saved for future use on the project. The file is saved with a
*.job extention. Select File>Save As...

FZ{ [untitled] - Batch Print =) <
File Edit 3Specifications
==
# | File tdodel

1 chp. M234548pprosimatelluantities01.dgn COOT Default
2 chpro. A 2345E arthwork Quantities01.dgn COOT Default
3 cihproje. M2345GeneralM otesSheet0].dgn COOT Default
4 cihproje. M2345GeneralM otesSheet02 dgn COOT Default
5 cihprojectz. \123455tandardPlanList.dan COOT Default
B chprojectsh 12345 M 2345TileSheet. dgn CDOT Default
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The job file should be saved to the project in the appropriate folder under the

Plot_Sets folder seen below.

=l |2 Projects
=l I3 12345
+ ) Bridge
[# [J) Construction
[ Consuleants
| |2 Design
| |20 Hydraulics
| 2 Landscape_Environmental
| 233 Matkerials_Geotechnical
23 Miscellaneous
# (53 Planning
= |2 Plok_Sets
® (3 AD
= FIR
I FOR
3 ROWPR

H B O

The name of the file saved will display in the dialog box title.

F=12345.job - Batch Print

X

File Edit Specifications

Specifications Contralling Printing:

H2dSE & g & g

|F'rinter: 11#17 Printer

6. Select the Print icon to open the Print Batch dialog box.

F2112345.job - Batch Print

=T

File Edit Specifications

hedE & =]
Specifications Contralling Printing:
Printer: 11817 Printer
Frint Area: SHEET_Plot-Boundary
Lanaut; b aximize:
Drizplay: Az-lz Digplay
# | File k4 odel
1 cihpl M23458pproximateluantities0 . dagn COOT Default
2 cihpros A1235E arthwork Guantities0 .dgn CDOT Default
3 chproe. M2345GeneralMotesSheet0].dan COOT Default
4 cihproje. M12345GeneralMotezSheetD2 . dan COOT Default
5 cihprojects. \123455tandardPlanList.dgn CDOT Default
B cihprojectsh12345. M 2345Tile5Sheet. dgn CDOT Default
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The Print Batch dialog box has three settings to adjust, the Print Range, System
Printer and the Log File.

Print Batch

Print Range

0] gll o Set Up Spstem Printer... |
Log File

Filename: | M5_PLTFILES:batchpltlog Browsze. ..

[+ Clear Lag File Before Printing

_Browse.. |
|
ITI Cancel |

First, the Print Range can be set to All or Selection. The All toggle is used to batch
print all files attached to the batch process. If none of the files are highlighted in the
Batch Print dialog box, the Selection toggle is not available (shown dithered above).
If files are selected in the Batch Print dialog box, (this can range from one file to
multiple files), the Selection toggle is available and only the highlighted files will be
sent to the printer.

- ]

Print Batch

Print Fange

oAl ® Selection Set Up Spstem Printer... |
Log File

Filenamne: | M5_PLTFILES:batchpl.log Browsze. ..

[¥ Clear Log File Befare Printing

i
| —

] Cancel I

Note: Multiple files can be selected by holding down the Shift key or the Ctrl key at
the Batch Print dialog box.
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Next, select Set Up System Printer.

-

Print Batch

Print B ange

o gll ® Selection

i~ Log File

Set Up System Printer. ..

Filename: | M5_PLTFILES:batchpltlog

Browsze... | |

Then, select the printer you will be using and select Preferences.

‘21 Print

e

General ]

i~ Select Printer -

= HP9110-PCLA

[ HPITID-PS
¢
Statusg: Ready

Location: Denver Office - Tech Area

Comment: Dell Color Lazer)et

Fage Range
o gl

" Selection " Cument Page

S |

1| | .>:'

I Print tofile | Preferences

Find Printer...

Mumber of copies; i'l E:

Frint |

Cancel J Apply

|

Note: Your default Printer will be selected automatically.
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Look for the setting that specifies the paper size for the printer you selected. Select

the option for 11”x 17” or Tabloid paper size. Select OK when you have this set.

J_; Printing Preferences

Prirt Tagk Guick Sets

: :I'ype e .Q wick Set name here

Faper Options
[ Use different paper

Size iz 17 x 11 inches|
SDL;ICB i —
i Automatically Select le
TPD..'? s
j Plain Paper iv':
O I.Emulate Lazerlet Margins =

[ Syrmetical Marging

L2

| Advanced | Paper/Qualiy :_ Firishing | Effects | Calor

Print Huality
Nomal I
I QK. I[ Cancel ]

After you return to the Print dialog box, select Apply first and then the Print button.

2 Print

General ]

i Select Printer -

| HP9110-PCLE
|£2HPaL10-PS

0l —

Status: Ready

Location:  Denwer Office - Tech Area

Comment: Del Color Lazer)et

Page Fange
o Al

" Selection ¢ Current Page

§i v

@l
[~ Printtofile  Freferences
Firnd Printer...

Muraber of copies; ]1 E:

I Frint I

Cancel Il Apply I

Note: If you do not change the Printer Preferences, the apply button will not be
active so you will only need to select Print.
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Caution: The Print button does not send the batch print to the printer. Instead, the
Print Batch dialog box becomes active.

Finally, select Browse under Log File and select the location you want to save the
log to for this batch print process.

-

Print Batch

Print B ange

oAl ® Selection {Set p Systern Printer.
Log File

Filename: | M5_PLTFILES: batchpltlog Browsze. .
[+ Clear Log File Before Printing

Here is a sample log file generated from the batch print process. This verifies all the
settings and if any of the prints failed.

5 12345.job - Notepad =[x

File Edit Format VYiew Help

[Default sSpecifications] ~
Printer=11x17 Printer

Plotarea=SHEET_Plot-Boundary

Layout=Maximize

Display=As-Is Display

[DGH=c:hprojectsh1234 shdesignhdrawingsh 1234 5approximatequantitiesol. dgn]
MODEL=CDOT Default

DESC=Master Model

[DGM=cC:vprojectsi1234 ihvdesignidrawingsy12345Earthworkquantitiesol. dgn]
MODEL=CDOT Default

DESC=Master Model

[DGH=c:hprojectshl234 shdesignhdrawingsh12345Gener alnotessheet 01, dgn]
MODEL=CDOT Default

DESC=Master Model

[DGH=c:hprojectsh1234 shdesignhdrawingsh 1234 5Gener alhotessheet 02, don]
MODEL=CDOT Default

DESC=Master Model

[DGM=C:hprojectsi1234 ihvdesignidrawingshl23455tandardrlanList. dgn]
MODEL=CDOT Default

DESC=Master Model

[DGH=c:hprojectsi1234 hdesignidrawingsy12345Tit esheet. dgn]
MODEL=CDOT Default

DESC=Master Model

Version 03.02 Page 14 of 19 Updated June, 2007



CDOT Batch Printing.pdf

Select OK to send the files to the printer.

Print Batch

Print R ange
oAl ® Selection Set Up System Printer. .
Log File

Filename: | C:%Projectz412345\Plot_Sets\AD\batch

¥ Clear Log File Befare Printing

oK Cancel I

7. Creating PDF documents.

From the Batch Print Specifications Manager, select PDF Printer and select

Properties.
Types Specifications
Frinter 11417 Printer
Frint Area 8.5411 Printer
Layaut FDF Printer Rename...
Dizplay

Mew...

Copy...

i

Delete

The following dialog box will appear. Select Driver.

PDF Printer Properties

Frinker
ok
Diriver:  tionhPlatter Drivert\COOT-POFdriver.plt | —:—‘

; C |
Usze Sustem Printer ﬂ
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Select CDOT-PDFdriver.plt under Files and select OK.

Select Printer Driver File

File Directary

Lizt Files of Tvpe:
Printer Driver Files [*.plt]

|

Diirectories:
| COOT-PDFdriver.plt .AicroStationPlotter Drivers
| . i [T
CDOT-PDFdriver. plt [ Program Files
LDOT-Shaded_Frinterdrver. plt [ ok space-COOT
[ Standards-Glabal
[P MicroStation

= Platter Drriver

Dirives:

[@E:

=i

Cancel

Help

dii

The following PDF Printer Properties box will display. Here you can have your
batch prints sent to a single PDF file. Toggle on Print document to single file and

select Browse.

PDF Printer Properties

Output and Post Processing
Frint to: ™ File o

Printer
Driver:  honsPlotter DriversCOOT -PDFdriver. plt Diriver...
[Jze Spstem Printer |
Paper Orientation
Sige: 17411 | _
& inan ® | apdscape
& : : = P :
Y- 11,000 In .} Portrait

Mame...

T

Iv Frint document st to single il

Default document zet output flename [optionalli

Browse...

Cancel

Note: If you do not key in an output filename, the file will be saved to your Project

Plot_Sets folder as defined by your active Project selected in the MicroStation
Manager.
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You will be prompted to save the single PDF file. Locate the appropriate folder
under your project 55555/Plot_Sets folder as seen below. Key in the appropriate file
name and select OK.

Save Print As

File  Directory

Directories:
48P ot_Set.pdf C:AProjects\123454Flot_Setsh

[
[ Projects
[ 12345
= Plot_Sets
23 4D
ZIFIR
=1 FOR
1 ROwWFR

Cancel
Lizt Files of Type: Dinves:

* polf | Bc =] Help

dii

The file name and path will display in the PDF Printer Properties dialog box.
Select OK.

PDF Printer Properties

Prirter
Driver:  tionPlatter Driver\COOT-POFdriver. plt M
Use System Printer I Cancel
FelE Orientation
Si;;z EH;;D _ 71 ﬁ‘ Lands.cape
11,000 n__ ¥ ) Portrait

Output and Post Processing -
Printto: ™ File o MName...

e
|

W Frint document set ta single file

Default document set output flenarne [ophional):
C:\Projectsh 12345 Flat_Sets\12345Flat_Setpdf | |1
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8. Select the Print icon to open the Print Batch dialog box.

F2112345. job - Batch Print Ll
File Edit 3Specifications
O e dE] & =M=
Specifications Contralling Printing;
Printer: 11417 Printer
Frint Area: SHEET_Plot-Boundary
Layout: M aximize
Diizplay: Ag-lz Dizplay
# File pdodel
1 chpl M23458pproximateluantities0 .dgn COOT Defaul
2 chprol A12345E arthwork Quantities01 .dgn COOT Defaul
3 chproje. M2345GeneralMatesSheet01.dan COOT Defaul
4 chproje. \2345GeneralMotesSheetD2. dan COOT Defaul
5 chprojects.. 51 23455tandardPlanList.dgn . COOT Default
B chprojects\12345. M 2345TileSheet. dan COOT Defaul

Set the Log File location and select OK.

.

Print Batch

Print Hange

B |l ® Selection
Log File
Filename: |MS_PLTFILES:batchpltlog Browse...

[v Clear Log File Befare Frinting

Diocument Set Single File Dutput

Filename: | C:AProjectsi123454Plot_Setsh12345F at Browse...

I k. I Canicel ]

Note: When Batch Printing PDF’s, you do not have the option to select the system
printer at the Print Batch dialog box.

If you choose to create multiple PDF files, the name of the dgn file will be used.
This will have “-001” appended to it. For example, a PDF created from
12345EarthworkQuantitiesO1.dgn will be called 12345EarthworkQuantitiesO1-
001.pdf. If multiple SHEET_Plot-Boundary shapes reside in the same drawing, the -
001 appended to the file name will be incremented by one for each shape.
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9. To set the directory path for multiple PDF files, open the PDF Printer Properties
dialog box (see step 7 above). In the Output and Post Processing area, select
Browse and set the desired directory path.

PDF Printer Properties

Frinter
i Ok,
Diriver:  tionPlotter DriverCDOT-POF driver. plt Driver... —

; C |
lge Suztem Printer | ﬂ

Paper Orientation
Size: 17411 - | ,
T ® | andzcape
s . : - O ;
v 11.000 ih [} Puortrait

Output ahd Post Processing

Frintto: ™ File ' Device Mame...

I Directony: | ohprojects\1 23455 Plot_Sets', | I EIDWSEI
Frint Crnd: |

[Usze Z%F to reprezent print file)

[ Print docurnent set bo single file
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